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Prerequisites

1 Introduction

This instruction describes how to replace an NPU1 C with an NPU1 D, and
how to move the existing licenses from the NPU1 C to the NPU1 D by reusing
the RMM from the NPU1 C. Hardware management is described in HW
Management Overview, Reference [6].

2 Prerequisites

The following sections include information about required preparations before
performing any hardware replacement.

2.1 Safety Information

Make sure that the information in the following documents has been understood
by the persons performing the procedures:
• Personal Health and Safety Information, Reference [8]
• System Safety Information, Reference [10]
• Supplementary Safety Information for MINI-LINK, Reference [9]

2.2 Required Tools and Equipment

The following tools and equipment are required when replacing an NPU1 C
with an NPU1 D:

• ESD wrist strap

• Torx screwdriver TX8 (M3)

• PC with MINI-LINK Craft installed and the electronic MINI-LINK TN CPI
library available (on-line or, when needed, off-line, locally downloaded)

• USB cable

2.3 Required Hardware

The following hardware is required when replacing an NPU1 C with an NPU1 D:
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• A MINI-LINK TN equipped with AMM 20p B

• NPU1 D

2.4 Required Licences and Software

NPU1 D requires Software Baseline (SBL) TN 5.4 or later.

To get the same functionality on the NPU1 D as on the NPU1 C, move the
licenses from the NPU1 C.

2.5 Required Documentation

Read through this document and make sure referenced documentation is
available during the replacement process. Ensure this by having the electronic
CPI library available on your PC. See Library Description on how to make it
available. It is recommended to print out a copy of the MINI-LINK TN Failure
Report, which can be found in Handling Faulty Equipment, Reference [5].

For a detailed description of the parameters mentioned in these instructions,
see MINI-LINK Craft User Interface Descriptions, Reference [7].

3 Flowchart

The flowcharts in this section describe the flow of the tasks needed to complete
the hardware replacement.
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Flowchart

Figure 1 Main Flow
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Figure 2 Removing an NPU1 C
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Flowchart

Figure 3 Adding an NPU1 D
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4 Replacing an NPU1 C with an NPU1 D

The following sections describe how to replace an NPU1 C with an NPU1 D,
and how to move the existing licenses from the NPU1 C to the NPU1 D by
reusing the RMM from the NPU1 C.

4.1 Preparing a Site Visit

This section presents the preparations needed for a successful completion of
the procedures in this instruction. All these preparations can be performed both
locally and remotely.

4.1.1 Identifying Current Software

To identify which SBL is running on the NE:

1. Access the NE and start MINI-LINK Craft by following the instructions in
Accessing a Network Element, Reference [1].

2. In the Management Tree, right-click the NE.

3. Point to Tools, Software Upgrade, and click Software Upgrade.

4. On the Software Upgrade page, identify the current SBL running on the
NE.

4.1.2 Placing Files on an FTP Server

If the SBL needs to be upgraded, place the SBL files on a remote FTP server or
a local FTP server by following the instructions in Upgrading or Downgrading a
SW Baseline, Reference [11].

4.1.3 Preparing a Configuration File

Because the configuration file for the NPU1 C cannot be used to configure the
NPU1 D, it is recommended to prepare a configuration file for the NPU1 D
before visiting the site. For more information on configuration management,
see applicable Configuration Documents. For more information on preparing
and transferring a CLI script, see Preparing a CLI Script File Offline, Reference
[12], and Transferring a CLI Script File on Site, Reference [13].

It is also recommended to upload the existing configuration file for the NPU1
C and to generate a configuration report as a back up, in case the installation
of the NPU1 D fails. Do this by following the instructions in Backing Up and
Restoring a Configuration File, Reference [3] and Generating a Configuration
Report, Reference [4].
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4.2 Preparing the NE on Site

4.2.1 Starting the Local FTP Server

To start the local FTP server:

1. Access the NE locally and start MINI-LINK Craft by following the instructions
in Accessing a Network Element, Reference [1].

2. On the Tools menu, click FTP Server.

3. On the FTP Server page, under Starting and Stopping, click Start to
start the FTP server.

4.2.2 Verifying the Software Upgrade Preferences

To verify the software upgrade preferences:

1. In MINI-LINK Craft, in the Management Tree, right-click the NE.

2. Point to Tools, Software Upgrade, and click Preferences.

3. On the Preferences page, make sure Version Control is enabled. If
Version Control is disabled, it is recommended to perform an upgrade of
the SBL to enable Version Control before replacing the HW. See Section
4.2.3 on page 7 for more information on SBL upgrade.

Version Control checks if load modules comply to the active SBL. If
necessary, load modules are automatically upgraded or downgraded to
comply with the active SBL.

4.2.3 Upgrading the SBL

If an SBL upgrade is required, upgrade the SBL by following the instructions in
Upgrading or Downgrading a SW Baseline, Reference [11].

4.3 Replacing the Hardware

Note: Before performing the replacement, make sure that the required
configuration file is on the local FTP server, and that the required SBL
with Version Control enabled is running on the NE.

Make sure the local FTP server has been started as described in
Section 4.2.1 on page 7.

This section describes how to replace the hardware and how to move licenses
from the NPU1 C to the NPU1 D by reusing the RMM from the NPU1 C.

Replacing an NPU1 C interrupts traffic. When replacing two NPU1 C units
configured for Ethernet Switch Protection, both NPUs must be removed and
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both slots cleared before an NPU1 D is inserted. This means that Ethernet
Switch Protection does not protect the NE during the replacement.

Replacing an NPU1 C interrupts the following traffic types:

• Traffic connected to the PDH Interfaces at the NPU1 C front panel

• Traffic connected to the Ethernet Interfaces at the NPU1 C front panel

• Traffic routed through the NPU1 C for robbed timeslot DCN connections

• Ethernet traffic connected through the NPU1 C backplane

• DCN connections to all far-end NEs

4.3.1 Removing an NPU1 C

Caution!

Electrostatic Discharge (ESD) may damage the equipment. Always use an
approved ESD wrist strap to avoid damage to components fitted on printed
circuit boards.

To minimize downtime when removing two NPU1 C units configured for
Ethernet Switch Protection, do as follows:

1. Set the Ethernet Switch in the NPU in the primary slot to active.

2. Remove the NPU in the secondary slot according to the procedure
described in Section 4.3.1.2 on page 10.

3. Remove the NPU in the primary slot according to the procedure described
in Section 4.3.1.1 on page 8.

4.3.1.1 Removing an NPU1 C from the Primary Slot

Remove an NPU1 C from the primary slot by performing the following steps:

1. Clean any switch ports connected to the NPU1 C by assuring that the
following conditions are met:

• The port is not a member of any VLAN. See Configuring an Ethernet
Layer 2 Connection, Reference [17].

• The port is not a member of any LAG. See Configuring Link Aggregation
Groups (LAG), Reference [18].
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• The port has no bandwidth policing. See Configuring Quality of Service,
Reference [19].

• The port has no RSTP or MSTP enabled. See Configuring Spanning
Tree, Reference [20].

• The port has no MAC white list connected. See Configuring Ethernet
Security and Admission Control, Reference [21].

• The port is not member of any mirror connection. See Performance
Management Operations, Reference [22].

2. Delete any Layer 1 connections to the NPU1 C, see Configuring an
Ethernet Layer 1 Connection, Reference [23].

3. Press the BR button gently and release it. This action is a request to
change the status of the NPU1 C to Out of Service and all traffic-related
alarms are disabled.

Note: Press the BR button before removing the NPU1 C, even if the
Power (green) LED is OFF.

6148b

Power
BR

OFF ON Flashing

LED
Symbols

4. Wait until the BR (yellow) LED is ON. This takes up to 60 seconds.

5. If the LED is not ON within 60 seconds, press and release the BR button
again. Wait another 60 seconds and if the LED is still not ON, move on to
the next step anyway.

6. Disconnect all cables and SFPs, undo the screws on the latches, and
remove the NPU within 90 seconds.
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Note: If you do not remove the NPU1 C within 90 seconds, the NPU
automatically performs a cold restart and the unit is taken into
service in about 180 seconds. The amount of time may vary
depending on the circumstances.

When the unit performs a cold restart, several traffic types are
interrupted as described in Section 4.3 on page 7.

7. Remove the RMM from the NPU.

ERICSSON

NPU1 C

TR2/LAN TR5 OUT TR5 IN OUT TR4 IN

O&M

TR:3A-3D TR:2A-2D User  I/O:1A-1I

F P
BR

NPU1 C
11981

RMM

RYS 110 243/1      P1A
BS80000001 20051101

Barcode 128

INSERT

4.3.1.2 Removing an NPU1 C from the Secondary Slot

Remove an NPU1 C from the secondary slot by performing the following steps:

1. Clean any switch ports connected to the NPU1 C by assuring that the
following conditions are met:

• The port is not a member of any VLAN. See Configuring an Ethernet
Layer 2 Connection, Reference [17].

• The port is not a member of any LAG. See Configuring Link Aggregation
Groups (LAG), Reference [18].

• The port has no bandwidth policing. See Configuring Quality of Service,
Reference [19].

• The port has no RSTP or MSTP enabled. See Configuring Spanning
Tree, Reference [20].

• The port has no MAC white list connected. See Configuring Ethernet
Security and Admission Control, Reference [21].

• The port is not member of any mirror connection. See Performance
Management Operations, Reference [22].

If these connections are still present, clearing the position in Step 9 results
in an error.

10 107/1543-HRA 901 20-V11 Uen B | 2015-12-01

urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring an Ethernet Layer 2 Connection
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring an Ethernet Layer 2 Connection
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring Link Aggregation Groups (LAG)
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring Link Aggregation Groups (LAG)
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring Quality of Service
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring Spanning Tree
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring Spanning Tree
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring Ethernet Security and Admission Control
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Configuring Ethernet Security and Admission Control
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Performance Management Operations
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Performance Management Operations


Replacing an NPU1 C with an NPU1 D

2. Delete any Layer 1 connections to the NPU1 C, see Configuring an
Ethernet Layer 1 Connection, Reference [23].

If these connections are still present, clearing the position in Step 9 results
in an error.

3. Press the BR button gently and release it. This action is a request to
change the status of the NPU1 C to Out of Service and all traffic-related
alarms are disabled.

Note: Press the BR button before removing the NPU1 C, even if the
Power (green) LED is OFF.

6148b

Power
BR

OFF ON Flashing

LED
Symbols

4. Wait until the BR (yellow) LED is ON. This takes up to 60 seconds.

5. If the LED is not ON within 60 seconds, press and release the BR button
again. Wait another 60 seconds and if the LED is still not ON, move on to
the next step anyway.

6. Disconnect all cables and SFPs, undo the screws on the latches, and
remove the NPU within 10 minutes.

Note: If you do not remove the NPU1 C within 10 minutes, it is
automatically taken into service. It is also possible to take the unit
into service before the end of the 10 minutes by pressing the BR
button again.

7. In the Management Tree, right-click the NE.

8. Point to View Status and click Slot State. The Slot Status Table appears.

9. Select the Clear check box for the position with state Inaccessible Unit.

Note: When selecting Clear, the NE removes the configuration for the
NPU1 C and it is not possible to recover.
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10. On the File menu, click Save.

11. In the Management Tree, right-click the NE.

12. Point to View Status and click Alarms, and make sure that the icon is
not shown.

4.3.2 Adding an NPU1 D

Caution!

Electrostatic Discharge (ESD) may damage the equipment. Always use an
approved ESD wrist strap to avoid damage to components fitted on printed
circuit boards.

Note: When replacing two NPU1 C units configured for Ethernet Switch
Protection, both units must be removed and both positions cleared
before inserting a new NPU1 D.

To minimize downtime when adding two NPU1 D units, insert and configure an
NPU1 D in the primary slot, before inserting an NPU1 D into the secondary slot.

4.3.2.1 Adding an NPU1 D to the Primary Slot

To add an NPU1 D to the primary slot, and move the licenses from the NPU1 C
to the NPU1 D by reusing the RMM from the NPU1 C:

1. Remove the NPU1 D from the ESD-protective packaging.

2. Insert the RMM from the NPU1 C into the RMM holder on the NPU1 D.

ERICSSON

NPU1 D

SYNC

2 MHz

TR:3 TR:2

TR:5/LAN

10/100/1000 BASE-T

SYNC

1PPS + ToD

TR:6

10/100/1000 BASE-T 

O&M

F P
BR

User  I/O

NPU1 D

TR:4

1G/10G BASE-T/X 1G/10G BASE-T/X

1000 BASE-T/X

17189

RMM

RYS 110 243/1      P1A
BS80000001 20051101

Barcode 128

INSERT
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3. Insert the NPU1 D by pressing it until it connects to the back of the subrack.
To make sure the NPU is inserted straight into the subrack, slowly push
the front panel of the NPU using an even force with two fingers close to the
two ends of the front panel.

Note: The event Compliant software running is triggered when a
plug-in unit with a software load module version that is later than
that in the current SBL has been inserted and accepted. This is
displayed only as information and requires no action from the user.

4. Press and release the BR button while the Fault (red), Power (green), and
BR (yellow) LEDs are ON (NPU power up).

5. Wait until the BR (yellow) LED starts flashing, indicating that the NE is
in NPU Installation mode.

6. Use the two latches to lock the NPU1 D and tighten the screws to secure it.

Note: If the screw is covered by a label, fold back the label before
tightening the screw. Cover the screw with the label when finished
tightening.

7. Connect the SFPs.

8. Connect all cables, including the USB cable.

9. Start MINI-LINK Craft by following the instructions in Accessing a Network
Element, Reference [1].

10. Wait until MINI-LINK Craft displays the Restore NPU Configuration page.

11. On the Restore NPU Configuration page, select Factory Settings from
the Select Configuration list to remove the current configuration on the
RMM.

12. On the File menu, click Save. The NPU restarts.

13. Configure the NPU1 D as a new unit using a configuration file from the local
FTP server, or manually. For more information on how to configure the
NPU using an configuration file on the local FTP server, see Backing Up
and Restoring a Configuration File, Reference [3].

4.3.2.2 Adding an NPU1 D to the Secondary Slot

To add an NPU1 D to the secondary slot:

1. Remove the NPU1 D from the ESD-protective packaging.

2. Insert the NPU1 D by pressing it until it connects to the back of the subrack.
To make sure the NPU is inserted straight into the subrack, slowly push
the front panel of the NPU using an even force with two fingers close to the
two ends of the front panel.

13107/1543-HRA 901 20-V11 Uen B | 2015-12-01

urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Accessing a Network Element
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Accessing a Network Element
urn:x-ericsson:r2:reg-doc:*-*:*:*#RestoreNPUConfiguration?title=MINI-LINK Craft User Interface Descriptions
urn:x-ericsson:r2:reg-doc:*-*:*:*#RestoreNPUConfiguration?title=MINI-LINK Craft User Interface Descriptions
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Backing Up and Restoring a Configuration File
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Backing Up and Restoring a Configuration File


Replacing an NPU1 C with an NPU1 D

Note: The event Compliant software running is triggered when a
plug-in unit with a software load module version that is later than
that in the current SBL has been inserted and accepted. This is
displayed only as information and requires no action from the user.

3. Use the two latches to lock the NPU1 D and tighten the screws to secure it.

Note: If the screw is covered by a label, fold back the label before
tightening the screw. Cover the screw with the label when finished
tightening.

4. Connect the SFPs.

5. Connect all cables.

6. Start MINI-LINK Craft by following the instructions in Accessing a Network
Element, Reference [1].

7. Configure the NPU1 D as a new unit manually.

4.3.2.3 Licensing Mode

The licensing mode information is stored in the internal flash memory of the
NPU. Replacing an NPU1 C with an NPU1 D affects the licensing mode, even
if the RMM from the old NPU is used. The licensing mode of the new NPU
is applicable after the replacement.

The possible replacement cases in the primary slot are the following:

• If the new NPU has never been used with MINI-LINK TN 5.4 or later and
there are missing licenses, the NE enters Software Upgrade Unlocked
Period after an upgrade to MINI-LINK TN 5.4 or later.

• If the new NPU has never been used with MINI-LINK TN 5.4 or later and all
the required licenses are installed on the RMM, the NE enters locked mode
after an upgrade to MINI-LINK TN 5.4 or later.

• If the new NPU has been used with MINI-LINK TN 5.4 or later before, the
NE enters the licensing mode that is connected to the new NPU.

• If the new NPU is from the factory with MINI-LINK TN 5.4 or later, the NE
enters locked mode.

Note: If the new licensing mode after the NPU replacement is not according to
user preferences, user action is required to enter the correct licensing
mode.

When the NE is not in unlocked mode after the NPU replacement, it is
only possible to configure an unlocked period when there are available
unlock tokens.

For more information about the license system, see MINI-LINK TN License
System, Reference [24].

14 107/1543-HRA 901 20-V11 Uen B | 2015-12-01

urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Accessing a Network Element
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=Accessing a Network Element
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=MINI-LINK TN License System
urn:x-ericsson:r2:reg-doc:*-*:*:*?title=MINI-LINK TN License System


Replacing an NPU1 C with an NPU1 D

4.4 Concluding Routines

Perform the following concluding routines before leaving the site.

4.4.1 Checking Active Alarms

To check active alarms:

1. In MINI-LINK Craft, in the Management Tree, right-click the unit.

2. Click Alarms.

3. If alarms are active on the Alarms and Status page, perform corrective
actions for each active alarm as described in Alarm Descriptions, Reference
[2].

4.4.2 Checking Current SBL

To check Software Baseline (SBL):

1. In MINI-LINK Craft, in the Management Tree, right-click the NE.

2. Point to Tools, Software Upgrade and click Software Upgrade.

3. On the Software Upgrade page, identify the current SBL running on the
NE.

4. If the current SBL is not the desired SBL, upgrade the SBL by following the
instructions in Upgrading or Downgrading a SW Baseline, Reference [11].

4.4.3 Handling Faulty Units

If the old unit was faulty, follow the instructions in Handling Faulty Equipment,
Reference [5].
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